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1 Summary of Changes 

This section is included for future use.  It will be used to describe changes to this 
document for each release and document version. 
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2 About This Guide 

This guide provides step-by-step procedures and reference information for Reception 
Console SMB version (R14 sp6). 

NOTE: NGT Reception Console is herein referred to as Reception Console or Reception 
Console SMB. 

2.1 Audience 

This document is intended for end users of the Reception Console application. 

2.2 How This Guide is Organized 

Section 3 Reception Console Overview gives an overview of Reception Console and 
outlines the general functionality. 

2.3 Additional Resources  

For feature information, see the following NGT guide: 

 NGT End-User Web Interface Guide, Release 6.0 
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3 Reception Console Overview  

Reception Console is a carrier class Internet Protocol (IP) Telephony Attendant Console, 
specifically developed for hosted environments.  It is used by “front-of-house” receptionists 
or telephone attendants, who screen inbound calls for companies.  Reception Console 
realizes the promise of IP Telephony by enhancing business processes and delivering rich 
services in a user-friendly way. 

Reception Console delivers the following real benefits to users: 

 An elegant design that is aesthetically pleasing 

 An ergonomic design that follows the natural work “flow” of a call from the top to the 
bottom of the screen 

 Improved business processes as only “valid” options are presented to the attendant 

 Professional call handling as critical information is available in “real time” 

 Accurate delivery of messages through a one-step process when people are 
unavailable 

Along with this focus on design, Reception Console employs the latest technology 
platforms and communications facilities. 
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3.1 Reception Console SMB   

The Reception Console SMB targeted at front office personnel in small and mid-sized 
organizations that do not require multiple directories, call queuing, or other advanced 
features.  It supports a full set of call control functions and monitoring of up to 30 lines in 
the directory. 

3.1.1 User Interface  

Figure 1 shows the main interface of Reception Console SMB. 

 

Figure 1  Reception Console SMB Main Interface 

The interface contains the following areas: 

1.  Switchboard panel 

2.  Directory panel 

3.  Options panel 

4.  Control panel 

For more information, see section 5 Reception Console Interface and Setup. 

The Reception Console SMB interface also contains the following: 

 Title bar – Displays the name of your version of Reception Console. 

 Menu bar – Contains menu items used to configure various settings and provide 
information about Reception Console. 

These menu items are described in section 6 Menu Bar. 
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The menu items that contain information specific to Reception Console SMB are as 
follows:  Tools – Options, Tools – Call History, View – Company Information, and View – 
Directories.  They are shown in the following figures. 

Figure 2 shows the Reception Console SMB Tools – Options dialog box. 

 

Figure 2  Reception Console SMB Tools – Options 

The Tools – Options dialog box provides the following tabs: 

 General 

 Connection 

 Day/Night Mode 

 Directories 

 Theme 

 Updates 

 About 

 

For more information, see section 6.4.2 Tools – Options. 
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Figure 3 shows the Reception Console SMB Tools – Call History dialog box. 

 

Figure 3  Reception Console SMB Tools – Call History 

The Tools – Call History dialog box provides the following tabs: 

 Dialed Calls 

 Received Calls 

 Missed Calls 

 

For more information, see section 6.4.1 Tools – Call History. 

Figure 4 shows the Reception Console SMB View menu. 

 

Figure 4  Reception Console SMB View Menu 

The View menu allows you to select directories you want to access from the Contact 
Directory panel. 

 

For more information on the View menu, see section 6.2 View Menu. 
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3.1.2 Call Management Functionality  

This section lists call management functions of Reception Console SMB and provides you 
with pointers to sections of this document where they are described: 

Function Described in Section 

Dial Contact 7.1.1 Dial Contact 

Dial Ad Hoc Number 7.1.2 Dial Ad Hoc Number 

Speed Dial 7.1.3 Speed Dial 

Answer Call 7.2 Answer Call 

Hold Call 7.3 Put Call on Hold 

Unhold Call 7.3.2 Unhold Call 

End Call 7.4 End Call  

Blind Call Transfer 7.5.1 Blind Transfer Call 

Supervised Call Transfer 7.5.2 Conduct Supervised Transfer 

Consulted Call Transfer 7.5.3 Conduct Consulted Transfer 

Transfer to Voice Mail 7.5.4 Transfer to Voice Mail 

Busy Camp On 7.5.5 Busy Camp On 

Directed Call Pickup 7.6 Conduct Directed Call Pickup 

Operator Call Barge-in 7.7 Conduct Operator Call Barge-in 

Start Conference Call 7.8.1 Start Conference Call 

Hold Conference Call 7.8.2 Hold Conference Call 

Unhold Conference Call 7.8.3 Unhold Conference Call 

Leave Conference Call 7.8.4 Leave Conference Call 

End Conference Call 7.8.5 End Conference Call 

Table 1  Reception Console SMB Call Management Functionality 
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4 Logging In 

This section describes the login procedures for the Reception Console application. 

4.1 First Time Login  

When starting Reception Console for the first time, several items must be correctly 
configured or checked. 

To start Reception Console on subsequent occasions, follow the procedure in section 4.2 
Subsequent Logins. 

To start Reception Console: 

1) Navigate to the program group Reception Console, followed by Reception 
Console. 

2) Click the Reception Console shortcut. 

 

Figure 5  Start Menu 

Reception Console starts and you are presented with the following login interface: 

 

Figure 6  Login Interface 
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3) From the Tools menu, select Options.  The Reception Console – Options dialog box 
opens. 

4) Click on the Connection tab and enter the server’s host name and port number for 
your service provider.  To obtain this information, contact your service provider. 

 

Figure 7  Options Dialog – Connection Page 
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5) Click on the Update tab and enter the proxy connection settings for your network, if it 
has a proxy server. 

 

Figure 8  Options Dialog – Updates Page 

6) Click OK. 

7) On the Login screen, enter your username and password and click Sign In. 
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4.2 Subsequent Logins  

1) Navigate to the program group Reception Console, followed by Reception 
Console. 

2) Click the Reception Console shortcut. 

 

Figure 9  Start Menu 

3) Click Sign In. 

 

Figure 10  Login Interface 
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5 Reception Console Interface and Setup  

This section provides a detailed description of the Reception Console interface.  The 
elements that are available only for a specific version of the Reception Console are 
identified as such. 

5.1 Switchboard Panel  

The Switchboard panel is located at the top of the Reception Console work area and 
shows all the ongoing calls. 

 

Figure 11  Switchboard Panel 

The Switchboard panel has the following components (from left to right): 

 The Link column lets you select the calls to be linked for a Consulted Transfer and 
Three-Way Conference.  You can select the calls to link by clicking in the Link column 
cell for the required call record row. 

The appearance of a chain link symbol  indicates the activation of this option.  
Clicking in the cell toggles the link option again. 

 The Line column shows the order that phone calls come in.  They start from 1 and 
continue. 

 The Call To (Called Party) column identifies the name of the party being called by the 
operator.  A name is typically displayed when the operator dials an internal number 
that is in the Contact directory.  For more information, see 7.1.1 Dial Contact.  A 
number is displayed for calls made to persons not in the Contact directory as well as 
most external calls. 

 The Extn (Extension) column displays the actual number dialed by the operator for 
internal calls. 

 The Call From (Calling Party) column identifies the person calling the operator.  For 
internal calls, this is the contact name assigned to the extension number in the 
Contact directory or the extension number, if no name has been assigned.  For 
external calls, the caller’s number is displayed unless the number is blocked (private) 
or the name is unavailable. 

 The Status column shows the state of calls on the operator switchboard (phone) and 
is color-coded as follows: 

Call State Display Status 

Active Active 

Held On Hold (00:00) (blinks after 45 seconds) 

Camp On Camped (00:00) (blinks after 45 seconds) 
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Call State Display Status 

Remote Held Active 

Ringing In (Remote) Incoming 

Ringing In (Local) Incoming 

Ringing Out Outgoing 

 
 The Time column displays the duration of the call, including the Ring Time, Hold Time, 

and Talk Time. 

5.2 Contact Directory Panel  

The Contact Directory panel is located as the third panel of the main interface and 
provides a listing of all contacts available to the operator. 

 

Figure 12  Contact Directory Panel 

5.2.1 Capabilities  

You are provided with the following capabilities: 

 Contact information 

 Convenient access to contact extension numbers and voice mail 

 Ability to view contact status 

 Ability to search contacts using a keyword 

 Ability to add, delete, and edit speed dial contacts 

 Call Management 

5.2.2 Directory Management Interface   

At the bottom of the Contact Directory panel there are several dialog boxes and buttons 
that assist you in managing directories: 

 The Keyword Search Filter text area allows you to enter a string you want to use to 
search for contacts, typically a contact’s name or phone number or part thereof.  The 
search returns all contacts containing the string as part of the selected directory field.  
For example, entering “Ann” and selecting “First Name” from the Keyword Search 
Filter List returns all contacts with the first name “Ann”, but it also returns all contacts 
with first names such as “Anne”, “Marianne”, “Marie Ann”, “Ann Marie”, and so on. 
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NOTE:  The keyword search is NOT case sensitive; the search for “Ann” or “ann” returns the 
same results. 

 The Keyword Search Filter drop-down list allows the operator to choose a directory 
field for a keyword search.  The value selected from this filter drop-down list is the 
column in which Reception Console searches for the keyword entered in the Search 
field, as well as the directory. 

 

Figure 13  Keyword Search Filter List 

 The Keyword Search Filter button, when clicked, enacts a keyword search based on 
the keyword and the Search fields. 

 The Reset button, when clicked, displays the full list of contacts, removing the effects 
of previous searches and filters. 

 The Add button allows you to add an entry to the directory currently displayed in the 
Contact Directory panel.  This button is only enabled for the Speed Dial directory. 

 The Edit button allows you to edit the entry currently selected in the Contact Directory 
Panel.  This button is only enabled for directories in which you have the ability to edit 
contact fields, such as the Speed Dial directory. 

 The Delete button lets you remove the entry currently selected in the Contact 
Directory panel.  This button is only enabled for the Speed Dial directory. 

 

For information about managing directories, see section 8  Managing Directories. 
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5.3 Directories  

The directory tabs at the top of the Contact Directory panel allow you to choose the 
directory you want to appear in the panel. 

 

Figure 14  Directory Heading Tabs 

The list of directories you can choose from depends on your version of Reception Console 
and your setup.  Table 2 lists the directories available for Reception Console. 

Directory Name Contents 

Contact Directory Other subscribers in your softswitch contact directory 

Personal Directory All contacts in your personal directory on the softswitch web portal 

Speed Dials Directory All numbers configured for you or by you for your Speed Dial 
service 

Monitored Contacts 
(previously called Phone 
Status Monitoring) 

A list of users, configured by the administrator, whose phone 
status you are currently monitoring (Monitoring limited to 30 users 
company- wide) 

Table 2  Reception Console Directories 

To show or hide directories tabs in the Contact Directory panel, select View and then 
Directories from the menu bar, and then select or deselect directory names. 

5.3.1 Contact Status Information  

The Call Status icon, available in some directories, in both List and Details view, shows 
the contact’s phone on-hook/off-hook state.  The color of the icon is customizable through 
the Tools – Options – Themes dialog box.  The following colors represent the default 
definitions: 

Call Status Icon Description 

Green Handset Down 
 

Contact phone is on-hook (available to receive a call). 

Red Handset Up 
 

Contact phone is off-hook (on a call, busy). 

Orange Handset Down 
 

Contact phone is ringing (previously this was a blue 
triangle). 

Do Not Disturb 
 

Contact phone has status set to “DND”. 

Grey Handset Down 
 

Contact phone state is currently unavailable or 
unknown. 

Private 
 

Contact phone state is set to “private”. 

Call Forwarding Always 
 

Contact has the Call Forwarding Always service turned 
on.  By hovering your mouse over the Call Forwarding 
Always contact, you can see the number the contact 
has set the Call Forwarding Always to. 

Figure 15  Call Status Legend 
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5.4 Options Panel  

The Options panel is located as the fourth panel of the main interface.  When the 
Reception Console interface is resized (full screen or otherwise), the Options panel size 
remains unchanged.  This allows for the Contact Directory panel to display a maximum 
number of contacts.  However, the size can be changed manually. 

 

Figure 16  Options Panel 

The Options panel is used to select call managing options and has the following 
components: 

 The Extn button allows you to transfer a call or make a call to the selected contact’s 
extension.  If this icon is grayed out, the contact does not have an extension number 
associated with the contact’s name in the Contact Directory.  Only the group/system 
administrator can modify this number. 

 The Phone button allows you to transfer a call or make a call to the selected contact’s 
phone number.  It is assigned to the same button as Extn and becomes visible when 
calling a phone number.  Only the group/system administrator can modify this 
number. 

 The Mobile button allows you to transfer a call or make a call to the selected contact’s 
mobile phone.  If this icon is grayed out, the contact does not have a mobile number 
associated with the contact’s name in the computer database.  Only the group/system 
administrator can modify this number. 

 The Voicemail button allows you to transfer a call to the selected contact’s voice mail.  
If this icon is dull or subdued in appearance, the contact does not have voice mail 
configured.  Only the group/system administrator can modify this number. 

 The Other button, when clicked, displays a dial pad used to enter an ad hoc number.  
It allows you to transfer a call or make a call to another number. 

NOTE:  The look of the buttons on the Options panel changes as they become available or 
unavailable.  If an option is available in a given context or operation, the corresponding button is 
active (colorful or highlighted); otherwise, it is grayed out or invisible. 

5.5 Control Panel  

The Control panel is used to execute call actions.  Call actions can also be performed by 
clicking Actions on the Menu bar and selecting the desired function.  When the Reception 
Console interface is resized (full screen or otherwise), the Control panel size remains 
unchanged.  This allows for the Contact Directory panel to display a maximum number of 
contacts.  However, the size can be changed manually. 

 

Figure 17  Control Panel 
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NOTE:  The look of the buttons on the Control panel changes as call actions become available 
or unavailable.  Several actions can be assigned to the same button.  When an action is active, 
the button changes to reflect that function.  When no action assigned to the button is active, the 
button is grayed out. 

The Control panel is used to execute call actions, and contains the following components, 
grouped by display button: 

 Dial button group: 

 The Dial button is used to start the dialing process to the number you have 
selected.  You can make a call to a contact when a contact is highlighted and you 
can make a call to another number when the dial pad has been used.  This button 
is subdued or muted in appearance when this action is not an option. 

 The Send button is used to send messages.  When messaging, the Dial button 
changes to Send. 

 Answer button group allows you to perform a variety of functions depending on the 
context of the active call.  The following dynamics change the button based on the call 
context: 

 The Answer button is enabled for incoming calls and allows you to answer a call. 

 The Hold Conference button is enabled when the selected call is in a conference 
and allows you to put the call on hold. 

 The Unhold Conference button is enabled when a conference is on hold and 
allows you to return it to the Active state. 

 The Hold button is enabled when a call is active and allows you to put it on hold. 

 The Unhold button is enabled when a call is on hold and allows you to unhold it. 

 Transfer button group allows you to perform a variety of functions depending on the 
context of the active call.  The following dynamics change the button based on the call 
context: 

 The Camp button allows you to camp the selected contact when the contact is in 
a Busy Call state. 

 The Uncamp button is enabled when the call is camped. 

 The Blind Transfer button is enabled when the contact selected is in an 
Available Call state. 

 The Voicemail button is enabled when the contact selected is in an Available Call 
state. 

 The Consulted Transfer button is enabled when two call parties are linked using 
the switchboard. 

 The Leave Conference button is enabled when a conference is in an Active state 
and you want to exit it. 

 The Conference button group allows you to perform a variety of control functions, 
depending on the context of the active call.  The following dynamics change the 
button based on the call context: 

 The Conference button is enabled when two call parties are linked on the 
switchboard and allows you to start a conference call. 
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 The End Conference button is enabled when a conference is active and allows 
you to end the conference call. 

 The Call Pick-Up button is enabled when the contact selected is in a Ringing Call 
state. 

 The Call Barge-in button is enabled when the selected contact is in a Busy Call 
state and allows you to barge in on the call. 

 The End button allows you to disconnect the selected switchboard call. 

 

For more information on call management functions, see section 7 Managing Calls. 
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6 Menu Bar  

The Menu bar is located at the top of the Reception Console main page.  It has the 
following menu items, described in the following sections:  File, View, Actions, Tools, and 
Help. 

6.1 File Menu 

The File menu allows you to sign out or exit Reception Console. 

 

Figure 18  Reception Console File Menu 

The File menu items are as follows: 

 Sign Out signs you out of Reception Console and displays the Login menu so that 
you can login again (possibly as a different user). 

 Exit signs you out and closes Reception Console. 

6.2 View Menu 

The View menu allows you to select which information you want to be visible in Reception 
Console. 

 

Figure 19  Reception Console View Menu 

The View menu items are as follows: 

 The Directories item allows you to select which directories you want to be visible in 
Reception Console.  The selected directories are displayed as tabs at the top of the 
Contact Directory panel. 

NOTE:  Directories listed on this menu depend on your Reception Console setup. 

6.3 Actions Menu 

The Actions menu lists all the phone management actions of Reception Console.  Only 
actions applicable at any given moment are active (highlighted).  All other menu items are 
grayed out. 
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Figure 20  Reception Console Actions Menu 

The use of actions is explained in context in the appropriate subsections in section  
7 Managing Calls. 
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6.4 Tools Menu 

The Tools menu contains various tools that help you set up and manage Reception 
Console. 

 

Figure 21  Reception Console Tools Menu 

The tools are Call History and Options.  They are described in the following sections. 

6.4.1 Tools – Call History 

The Call History dialog box is used to view and delete the user’s call logs.  The dialog box 
can be displayed from the Menu bar by selecting Tools – Call History. 

 

Figure 22  Tools – Call History 

The dialog box in Figure 22 shows all possible call history tabs.  Depending on your 
version of Reception Console, some tabs may be unavailable to you. 

The following sections describe all the tabs, with those available only in some versions of 
the Reception Console clearly identified. 
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6.4.1.1 Dialed Calls Tab  

To see dialed calls, click the Dialed Calls tab. 

 

Figure 23  Call History – Dialed Options 

The records contain the following information: 

 Name is the name of the call recipient for internal numbers (where available from the 
company directory).  It can also be the number of the call recipient for external 
numbers or for internal numbers when no name is available. 

 Number is the number of the call recipient. 

 Time is the time of the call. 
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6.4.1.2 Received Calls Tab  

To see received calls, click the Received Calls tab. 

 

Figure 24  Call History – Received Calls 

The records contain the following information: 

 Name is the name of the caller for internal numbers (where available from the 
company directory).  It can also be the number of the caller for external numbers or for 
internal numbers when no name is available. 

 Number is the number of the caller. 

 Time is the time of the call. 
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6.4.1.3 Missed Calls Tab  

To see missed calls, click the Missed Calls tab in the Calls History dialog box. 

 

Figure 25  Call History – Missed Calls 

The records contain the following information: 

 Name is the name of the caller for internal numbers (where available from the 
company director).  It can also be the number of the caller for external numbers or for 
internal numbers when no name is available. 

 Number is the number of the caller. 

 Time is the time of the call. 
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6.4.1.4 Delete Call History Logs  

You can delete one entry, multiple entries, or all entries in the Call History tab.  To delete 
the call logs, do the following: 

1) Select the call entry by clicking on it with the mouse or holding down TAB and using 
the arrow keys.  For selecting consecutive entries, hold down SHIFT while selecting 
the calls.  If you want to select multiple calls that are not together, hold down CTRL 
and select the desired calls.  To select all the calls in the open dialog, whether that 
includes the dialed, received, or missed calls, click Select All. 

 

Figure 26  Select All Button 

Alternatively, if you want to delete all of the call history entries, click the Clear All 
button. 

 

Figure 27  Clear All Button 

2) A warning message asks for your confirmation.  Select Yes. 

 

Figure 28  Call History Confirmation Message 

The entries are now cleared. 

NOTE:  This functionality is only available if you have been assigned this feature by your system 
administrator.  If you do not have sufficient permission to perform this action, a service error 
message informs you of this. 
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6.4.2 Tools – Options  

The Tools dialog box is used to configure user/service provider settings and preferences.  
The dialog box can be displayed from the Menu bar by selecting Tools and then Options.  
It is available on both the login and main interface pages. 

 

Figure 29  Tools – Options 

The dialog box in Figure 29 displays all Reception Console options.  Depending on your 
version of Reception Console, some options may be unavailable to you.  The following 
sections describe all the options, with options available only to some versions of the 
Reception Console clearly identified. 
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6.4.2.1 General Tab  

The General tab contains miscellaneous features that improve the usability of Reception 
Console. 

 

Figure 30  Options – General 

The General Options are as follows: 

 Auto login when connected to network enables Reception Console to automatically 
connect and log in to the server when it detects a network connection. 

The Alerts are as follows: 

 Auto switch focus on incoming call enables Reception Console to automatically take 
window focus over other applications when a new incoming call is received. 

Language option: 

 The Language available is the default, English (U.S.).  The language option is: 

 English (U.S.) 

Selecting the desired language, click OK and restart Reception Console for the 
changes to take place. 

 Synchronize language with service profile, when checked, enables Reception 
Console to automatically match the application language to the language set within 
the softswitch subscriber’s profile after signing in. 

NOTE:  If no profile match is found, the language remains set to the current language. 
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6.4.2.2 Connection Tab  

Click on the Connection tab to configure the connection information required to connect to 
your service provider. 

 

Figure 31  Options – Connection 

The Server Connection Information is as follows: 

 The Host Address is the host name/IP address for service.  This is compulsory and 
can be obtained from the service provider. 

 The Host Port is the port number for service.  This is compulsory and can be obtained 
from the service provider. 
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6.4.2.3 Day/Night Mode Tab 

The Day/Night Mode tab configures day/night mode call settings.  This is useful to turn on 
at the end of your work day when you want to forward calls either to another number or to 
your voice mail.  This tab is only configured once you have logged in. 

 

Figure 32  Options – Day/Night Mode 

The Day/Night Mode options are as follows: 

 The Night mode option turns the night mode on and off. 

 Forward calls to forwards incoming calls to the specified phone number.  All calls 
to your extension are directly forwarded to this number. 

 Forward calls to voice mail option forwards incoming calls to your voice mail.  All 
calls to your extension are directly forwarded to your voice mail.  Your voice mail 
must be set up properly for this to work. 

6.4.2.4 Directories Tab   

Click on the Directories tab to configure which directory is visible on startup of Reception 
Console. 
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Figure 33  Options – Directories 

The Directory Options allows you to select the directory you want to appear in the Contact 
Directory panel at startup. 

Click on the Start-Up Directory drop-down list to select the “Last viewed” directory or any 
other directory available to you. 
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6.4.2.5 Theme Tab   

Click on the Theme tab to modify the look and feel of Reception Console. 

 

Figure 34  Options – Theme 

The configuration of the look and feel of Reception Console is categorized as follows: 

 Global font type 

 Standard control font style 

 Panel header font style 

 Slide panel header font style 

 Login panel color 

 Login panel font color 

 Login panel logo 

 Login panel background image 

 Switchboard panel color 

 Switchboard panel font color 

 Contact directory panel color 

 Contact directory panel font color 

 Contact status icon for “unknown” 

 Contact status icon for “on hook” 
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 Contact status icon for “off hook” 

 Contact status icon for “call incoming” 

 Contact status icon for “do not disturb” 

 Contact status icon for “call forward always” 

 Contact status icon for “private” 

 Option panel color 

 Option panel font color 

 Option panel button font style 

 Dial pad font style 

 Control panel color 

 Control panel font color 

 Control button font style 

For a selected item, the components may be chosen from the Component drop-down 
menu. 

 

Figure 35  Options – Component Selection 

Global font type  

Altering this theme component enables you to change the font of all of the text used in 
Reception Console.  This includes numerals and menu items. 
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Standard control font style  

Altering this theme component changes the size and font style of the text throughout 
Reception Console.  The size ranges from 8 through 16.  The different types are plain, 
bold, and italic. 

Panel header font style  

Altering this theme component changes the size and type of the text on all the main 
screen panel headers situated to the left of the panels.  The affected panels are the 
Switchboard panel, the Queue panel, the Contact Directory panel, the Options panel, and 
the Control panel.  The size ranges from 8 through 16 and the different types are plain, 
bold, and italic. 

Slide panel header font style  

Altering this theme component changes the size and type of the text on all main screen 
slide panel headers.  The affected components are the Company Notes, the Company 
profile, and the Alphabetical Index slide panel headers.  The size ranges from 8 through 
16 and the different types are plain, bold, and italic. 

Login panel color  

Altering this theme component enables you to change the color of the Login screen 
background.  This is a standard grey unless modified. 

Login panel font color  

Altering this theme component changes the color of the font located on the Login screen.  
The user name, password, and check boxes change to the chosen color. 

The text would ideally be changed to white for darker title bar panel colors or black for 
lighter title bar panel colors.  All you must do is make sure that the color combination you 
decide on does not render the text illegible. 

Login panel logo  

Altering this theme component enables you to change the logo located at the bottom right-
hand corner of the login interface.  This component can only be modified with a GIF, 
JPEG, or PNG graphic file that is approximately 180 x 64 pixels in size. 

Login panel background image  

Altering this theme component enables you to change the login interface background 
image.  This component can only be modified with a GIF or JPEG graphic file that is 
approximately 269 x 272 pixels wide.  The interface automatically scales graphics that are 
smaller or larger than needed. 

Switchboard panel color  

Altering this theme component enables you to modify the background color of the 
Switchboard panel, Company Notes and Profile, and Queue panel.  All other components 
within this panel are set to “black” or “white” percentage transparencies of this panel color.  
When modifying this component, make sure it is of a color depth that allows for legibility of 
the text and other elements within this panel. 

Switchboard panel font color  

Altering this theme component changes the color of the font located on the Switchboard 
panel, Company Notes and Profile, and Queue panel.  The text would ideally be changed 
to white for darker title bar panel colors or black for lighter title bar panel colors.  All you 
must do is make sure that the color combination you decide on does not render the text 
illegible. 
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Contact directory panel color  

Altering this theme component enables you to modify the background color of the Contact 
Directory panel.  All other components within this panel are set to “black” or “white” 
percentage transparencies of this panel color.  When modifying this component, make 
sure it is of a color depth that allows for legibility of the text and other elements within this 
panel. 

Contact directory panel font color  

Altering this theme component changes the color of the font located on the Contact 
Directory panel, Alphabetical Index, and Directory tabs.  The text would ideally be 
changed to white for darker title bar panel colors or black for lighter title bar panel colors.  
All you must do is make sure that the color combination you decide on does not render the 
text illegible. 

Contact status icon – “Unknown”  

Altering this theme component changes the image used to show an “unknown” or 
unavailable call.  The standard image is a grey phone.  This component can only be 
modified with a GIF or JPEG graphic file that is approximately 7 x 16 pixels wide. 

Contact status icon – “On Hook”  

Altering this theme component changes the image used to show an “on hook” or available 
call.  The standard image is a green phone.  This component can only be modified with a 
GIF or JPEG graphic file that is approximately 7 x 16 pixels wide. 

Contact status icon – “Off Hook”  

Altering this theme component changes the image used to show an “off-hook” call.  An 
“off-hook” call means the contact is already on a call or is busy.  The standard image is a 
red phone.  This component can only be modified with a GIF or JPEG graphic file that is 
approximately 7 x 16 pixels wide. 

Contact status icon – “Call Incoming”  

Altering this theme component changes the image used to show a “Call incoming” call.  
The standard image is an orange phone.  This component can only be modified with a 
GIF or JPEG graphic file that is approximately 7 x 16 pixels wide. 

Contact status icon – “Do Not Disturb”  

Altering this theme component changes the image used to show a “Do Not Disturb” call.  
“Do Not Disturb” is set by the contact.  The standard image is a stop sign.  This 
component can only be modified with a GIF or JPEG graphic file that is approximately 
7 x 16 pixels wide. 

Contact status icon – “Call Forwarding Always”  

Altering this theme component changes the image used to illustrate a “Call Forwarding 
Always” call.  “Call Forwarding Always” is set by the contact.  The standard image is a stop 
sign.  This component can only be modified with a GIF or JPEG graphic file that is 
approximately 7 x 16 pixels wide. 

Contact status icon – “Private”  

Altering this theme component changes the image used to illustrate a “Private” call.  A 
“private call” means the contact has chosen to withhold their number.  The standard image 
is a red circle with a white dash through it.  This component can only be modified with a 
GIF or JPEG graphic file that is approximately 7 x 16 pixels wide. 
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Options panel color  

Altering this theme component enables you to modify the background color of the Options 
panel.  All other components within this panel are set to “black” or “white” percentage 
transparencies of this panel color.  When modifying this component, make sure it is of a 
color depth that allows for legibility of the text and other elements within this panel. 

Options panel font color  

Altering this theme component changes the color of the font located on the Options panel 
and the buttons.  Inactive buttons are a greyer shade of the color chosen.  The text would 
ideally be changed to white for darker title bar panel colors or black for lighter title bar 
panel colors.  All you must do is make sure that the color combination you decide on does 
not render the text illegible. 

Options panel button font style  

Altering this theme component changes the size and type of the text on the Options panel 
buttons.  The size ranges from 8 through 16 and the different types are plain, bold, and 
italic. 

Dial pad font style  

Altering this theme component changes the size and type of the text on the dial pad for the 
Other button.  This comes in to view when Other is clicked once.  The size ranges from 8 
through 16 and the different types are plain, bold, and italic. 

Control panel color  

Altering this theme component enables you to modify the background color of the Control 
panel.  All other components within this panel are set to “black” or “white” percentage 
transparencies of this panel color.  When modifying this component, make sure it is of a 
color depth that allows for legibility of the text and other elements within this panel. 

Control panel font color  

Altering this theme component changes the color of the font located on the Control panel 
and the buttons.  Inactive buttons are a greyer shade of the color chosen.  The text would 
ideally be changed to white for darker title bar panel colors or black for lighter title bar 
panel colors.  All you must do is make sure that the color combination you decide on does 
not render the text illegible. 

Control panel button font style  

Altering this theme component changes the size and type of the text on Control panel 
buttons.  The size ranges from 8 through 16 and the different types are plain, bold, and 
italic. 
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6.4.2.5.1 Theme Loading and Saving   

The theme refers to how the interface appears, which includes the colors in which the 
various panels, buttons, logos, and text are displayed, the size of each component, and 
the manner in which they are displayed in terms of spacing and size. 

The default theme such as “standard.thm” is used for the visual display of Reception 
Console, and this theme is automatically loaded when the application is turned on. 

If you, as a user, want to apply a different theme to the application, do the following: 

1) Select a theme from the Theme drop down menu. 

 

Figure 36  Theme Selection 

2) Click on Apply at the bottom right of the Options/Theme dialog box.  The settings of 
the selected theme take effect. 

3) You can create a new theme file by clicking on Save As at the bottom of the 
Options/Theme dialog box.  This brings up a new dialog box prompting you to enter a 
name for your new theme file. 

 

Figure 37  Theme – Save As 

4) After entering the name, click OK.  The theme file is saved. 

5) If you would like to apply this new theme file as your default, select it as explained 
above. 
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6.4.2.5.2 Theme Component Modification  

Color Components 

To make a change to any component, click Change and make your new selection.  When 
you click Change to change a color component, a dialog box is displayed allowing you to 
select a color.  The only exception to this is the Title Bar Icon Color component, for which 
only two alternatives are available, black and white. 

 

Figure 38  Theme Color Chooser 

There are three color choice tabs available.  The Swatches tab allows you to pick a 
particular color, HSB allows you to change the depth of that color, and RGB allows you to 
further alter that color by changing the percentage of red, green, and blue shades. 
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Image/Graphic Components 

1) Click Change to change an image component.  A dialog box is displayed allowing you 
to select an image/graphic file from your computer. 

 

Figure 39  Theme File Chooser 

2) Select a file that you want and click Open.  The selected image file replaces the 
component image being changed.Updates Tab   

Click on the Updates tab to configure the proxy information required to connect to a proxy 
server. 

 

Figure 40  Options – Updates 
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The Proxy Connection Settings options are as follows: 

 Use a proxy server to check for updates check box ensures that updates are checked 
by a proxy server automatically. 

 Type is the compulsory proxy server type.  HTTP is the accepted form. 

 Server is the compulsory proxy server URL and can be obtained from the network 
administrator. 

 Port is the proxy server connection port number.  It is compulsory and can be 
obtained from the network administrator. 

 User ID is the authentication user ID that is required if user authentication is required 
by the proxy server. 

 Password is the authentication password that is required if user authentication is 
required by the proxy server. 

6.4.2.6 About Tab   

Click the About tab in the Call History dialog box to find version information and read the 
general disclaimer for Reception Console. 

 

Figure 41  Options – About 

The information displayed is as follows: 

 Reception Console Version 

 Reception Console Disclaimer 

The About tab is important in providing information for the purpose of technical support. 
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6.5 Help Menu 

The Help menu contains the following items: 

 User Guide – A link to a PDF version of this guide. 

 About Reception Console HIS – The same information as the Tools – Options About 
tab.  For more information, see section 6.4.2.6 About Tab. 

 

Figure 42  Reception Console – Help Menu 
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7 Managing Calls  

You manage calls using a combination of the panels in a top to bottom workflow style.  
You should be able to distribute calls typically using this workflow for most of the activities 
in the following subsections. 

The following subsections describe the call management functions available in Reception 
Console.  Functions available only in certain versions of Reception Console are identified 
as such. 

7.1 Dialing 

Dialing allows you to make calls to contacts in a variety of ways. 

7.1.1 Dial Contact  

To make a call to a contact: 

1) Find and select the contact you want to call by searching the Contact Directory or any 
other directory where the contact may be listed. 

 

Figure 43  Contact Directory Panel 

2) In the Options panel, select the option you want to use for this contact.  Possible 
options include the extension, mobile, or voice mail.  In most cases, an option (usually 
the contact’s extension) is selected by default.  To change the selected option, simply 
click another option once.  Unavailable options are dull or subdued in appearance. 

3) In the Control panel, click Dial.  Alternatively, click Actions on the Menu bar, and 
select Dial from the drop-down list. 

 

Figure 44  Dial Button 

NOTE:  The contact’s extension is dialed in preference to the number field when both are 
populated.  If there is no extension field provided, Reception Console attempts to dial using the 
number field. 
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The called party phone rings, and the call appears on the Switchboard panel as 
“Outgoing”.  When the call is answered by the destination number, the call is 
connected and you talk to the contact at that number. 

NOTE:  Alternatively, you can double-click a contact to dial the contact’s default call option 
(automatically selects extension, mobile, voice mail, in order of availability). 

7.1.2 Dial Ad Hoc Number  

To make a call to an ad hoc number (a person not listed in your Contact Directory): 

1) In the Options panel, click Other.  The dial pad appears. 

 

Figure 45  Other Button 

2) Enter the number you want to call either by typing the number on the keyboard or by 
selecting each number in turn from the dial pad using your mouse. 

3) Click the DIAL button on the Control panel.  Alternatively, click Actions on the Menu 
panel, and select Dial from the drop-down list. 

 

Figure 46  Dial Button 

The called party phone rings, and the call appears on the Switchboard panel as 
“Outgoing”.  When the call is answered by the destination number, the call is 
connected and you talk to the contact at that number. 
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7.1.3 Speed Dial 

To make a call via Speed Dial, perform the following steps: 

1) In the Contact Directory panel, select the Speed Dial tab.  This displays the Speed 
Dials directory. 

 

Figure 47  Speed Dial Directory 

2) From the directory, select the Speed Dial number you want to use. 

3) In the Control panel, click DIAL.  Alternatively, click Actions on the Menu panel, and 
select Dial from the drop-down list. 

 

Figure 48  Dial Button 

The called party’s phone rings, and the call appears on the Switchboard panel as 
“Outgoing”.  When the call is answered by the destination number, the call is 
connected and you talk to the contact at that number. 

NOTE:  Double-click the Speed Dial entry to make a call to the saved number.  For more 
information, see section 8.5 Manage Speed Dial Entries. 

7.2 Answer Call  

NOTE:  You must have a phone from the supported phone’s list; otherwise, undesirable behavior 
may occur.  For further information, contact your service provider. 

To answer a call: 

1) Select the call you want to answer from the Switchboard panel. 

 

Figure 49  Linked Switchboard 
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2) In the Control panel, click Answer.  Alternatively, click Actions on the Menu panel, 
and select Answer from the drop-down list. 

 

Figure 50  Answer Button 

NOTE:  You can answer the longest waiting incoming call by clicking the space bar key.  
Consecutive presses of the space bar place the previous active call on hold and answer the 
oldest incoming call.  This does not work if you are clicking on a text field. 

7.3 Put Call on Hold  

You put call on hold using the Hold button.  The call must be already in progress. 

7.3.1 Hold Call  

To place a call on hold: 

1) Select the call you want to put on hold from the Switchboard panel. 

 

Figure 51  Switchboard – Active Call 

2) Click HOLD on the Control panel to hold the call.  Alternatively, click Actions on the 
Menu panel, and select Hold from the drop-down list. 

 

Figure 52  Hold Button 
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7.3.2 Unhold Call  

To take a call off hold: 

1) Select the call you want to take of hold from the Switchboard panel. 

 

Figure 53  Switchboard – Held Call 

2) Click UNHOLD on the Control panel.  Alternatively, click Actions on the Menu bar, 
and select Unhold from the drop-down list. 

  

Figure 54  Unhold Button 

The call becomes active and the call status on the Switchboard panel changes from 
“On Hold” to “Active”. 

NOTE:  Alternatively, double-click on the held call on the switchboard panel. 

7.4 End Call  

To end a call: 

1) Select the call you want to end from the Switchboard panel. 

 

Figure 55  Linked Switchboard 

2) Disconnect the calling party by clicking End on the Control panel.  Alternatively, click 
Actions on the Menu panel, and select End from the drop-down list. 

 

Figure 56  End Button 

The calling party is disconnected when the End button is clicked. 
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7.5 Transferring Calls 

There are a number of ways in which you can transfer a call to another contact. 

7.5.1 Blind Transfer Call  

A blind transfer occurs when a call is transferred without an introduction.  Calls may be 
blind transferred while active, held, or ringing (in) on your phone.  If a call is ringing (in), the 
blind transfer activity allows the call to be redirected before it is answered.  This can be 
done via “drag and drop” or through the Control panel. 

To conduct a blind transfer using drag and drop: 

1) Click the call you want to transfer from the Switchboard panel with your left mouse 
button.  Your cursor changes to a hand grip to indicate the call is moveable. 

 

Figure 57  Hand Grip Cursor 

2) To scroll up or down a list, move the cursor over the corresponding corner of the 
contact directory.  To cancel the move at any time, press Esc. 

3) Drag the call to the target contact in your Contact Directory or Customized Directory, 
and let go of the left mouse button.  The call is now transferred.  If the target contact is 
busy, the call is camped. 

To conduct a blind transfer: 

1) Select the call you want to transfer from the Switchboard panel. 

2) Select the option to which you want to blind transfer the call.  This number may be the 
option for a contact from the Contact Directory, a speed dial, or another number of 
your choice entered using the Other dial pad. 

3) Click BLIND TRANSFER highlighted on the Control panel.  If the BLIND TRANSFER 
button is not highlighted, click Actions on the Menu panel, and then select Blind 
Transfer. 

 

Figure 58  Blind Transfer Button 

The call is now transferred and then removed from the Switchboard panel. 
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7.5.2 Conduct Supervised Transfer 

When you have an active inbound call that you want to transfer to another contact, do the 
following: 

1) Make sure that the first call is answered and active. 

2) Dial the number you want to transfer the call over to. 

The first call is automatically held. 

3) Click on the CONSULTED TRANSFER button on the Control panel to conduct the 
transfer.  If the Consulted Transfer button is not highlighted, click Actions on the 
Menu panel, and then select Consulted Transfer. 

 

Figure 59  Consulted Transfer Button 

NOTE:  If the dialed contact is busy, you can retry or dial another contact.  The call is transferred 
to the first available dialed contact. 

7.5.3 Conduct Consulted Transfer  

A consulted transfer allows the operator to announce or introduce the call to the called 
party.  A call may be consult-transferred while active, held, or ringing (out). 

To conduct a consulted transfer: 

1) Dial the contact you want to transfer the call to. 

2) When the call is connected, consult with the called contact. 

3) Link the two calls to be transferred together by clicking in the Link column on the 
Switchboard panel.  You must do this for both calls, thereby identifying the calls to link. 

 

Figure 60  Linked Switchboard 

4) To transfer the calls, click CONSULTED TRANSFER highlighted on the Control 
panel.  Alternatively, click Actions on the Menu panel, and select Consulted Transfer 
from the drop-down list. 

 

Figure 61  Consulted Transfer Button 

The calls are now transferred and removed from the Switchboard panel. 
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NOTE:  If you have an active call and place another call, these two callers are automatically 
linked on the Switchboard panel. 

7.5.4 Transfer to Voice Mail  

To transfer a call to voice mail: 

1) Select the call you want to transfer from the Switchboard panel. 

 

Figure 62  Switchboard 

2) From the contact directory, select the name of the contact containing the Voice Mail 
you want to transfer the call to.  Select yourself if you want to transfer the call to your 
voice mail. 

NOTE:  This option is only available if the contact you would like to transfer the voice mail to has 
the Voice Messaging service assigned and enabled. 

3) Select the call option by clicking VOICEMAIL on the Options panel. 

4) Transfer the call to voice mail by clicking VOICEMAIL TRANSFER on the Control 
panel.  Alternatively, click Actions on the Menu panel, and select Voicemail Transfer 
from the drop-down list. 

 

Figure 63  Voice Mail Button 

7.5.5 Busy Camp On 

Busy Camp On can only work if the user has Camp On activated and the party the user 
wants to transfer to is busy.  It allows the operator to hold and automatically transfer a call 
to a contact when the contact is available to take the call.  A call can be camped on a 
contact only if the call is active or held and if the status of the destination contact is either 
“Busy” or “Ringing”.  The call can be camped via drag and drop or by using control 
buttons. 

NOTE:  Busy Camp On is provisioned through the softswitch web portal. 
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7.5.5.1 Application Managed Mode 

This mode ensures the call stays on the user’s line.  Thus, the user has the option of  
taking a camped call off hold.  To find out which mode you have, contact your 
group/system administrator. 

To camp a call using drag and drop: 

1) Click the call you want to transfer from the Switchboard panel with your left mouse 
button.  Your cursor changes to a hand grip to indicate the call is moveable. 

2) To cancel the move at any time, press Esc. 

3) Drag the call to the target busy contact in your Contact Directory or Customized 
Directory and let go of the left mouse button.  The call is now camped at the contact’s 
extension and shows Camped status against the call on the Switchboard panel.  The 
calling party is muted while camped and hears the Music On Hold.  Once the contact 
is ready to take the call (contact status becomes “Online”), the call is automatically 
transferred and is removed from the Switchboard panel. 

To camp a call: 

1) On the switchboard, select the call that you want to camp. 

2) Open a directory in the Contact Directory panel and click the contact that you want to 
camp the call on. 

 

Figure 64  Switchboard View 

3) Click Extn on the Options panel. 

 

Figure 65  Directory Panel 

4) Click CAMP ON highlighted on the Control panel.  Alternatively, click Actions on the 
Menu panel, and select Camp-On from the drop-down list. 

 

Figure 66  Camp On Button 

The call is now camped at the contact’s extension and shows Camped status against 
the call on the Switchboard panel.  The calling party is muted while camped and 
hears the Music On Hold.  Once the contact is ready to take the call (contact status 
becomes Online), the call is automatically transferred and is removed from the 
Switchboard panel. 
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5) If you want to uncamp the call, select it on the Switchboard panel if you have not done 
this.  Click UNCAMP, which should be highlighted on the Control panel.  Alternatively, 
click Actions on the Menu panel, and select Uncamp from the drop-down list. 

 

Figure 67  Uncamp Button 

The call is now uncamped from the destination contact and shows On Hold status on 
the Switchboard panel.  This is useful if, for any reason, you want to retrieve a call 
from being camped. 

7.5.5.2 Service Managed Mode 

This mode ensures the softswitch service manages the camped call.  This functionality is 
only available if you have been assigned this service by your group/system administrator. 

To transfer a call to a busy user: 

1) Select the call from the switchboard. 

 

Figure 68  Switchboard View 

2) Select a busy contact from the Contact Directory. 

 

Figure 69  Directory Panel 

3) Click the CAMP ON button.  Alternatively, click Actions on the Menu panel, and 
select Camp-On from the drop-down list.  Once the call is camped, it is removed from 
the switchboard. 

 

Figure 70  Camp On Button 

The call is transferred after the receiving party becomes available and they are 
alerted. 

If the camped call reaches the designated expiration timer, the call is recalled to your 
device and flagged on the switchboard as “Recalled”. 
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7.6 Conduct Directed Call Pickup  

Directed Call Pickup allows the operator to pick up a call that is incoming on a contact.  
This is useful when you want to answer a call on the contact’s behalf or if the contact is 
currently not on hand to answer the call.  This functionality is only available if you have 
been assigned this service by your group/system administrator. 

To conduct a Directed Call Pickup: 

1) Select a contact who you want to pick up the call for.  The contact’s status must be 
“Ringing”. 

2) Click CALL PICKUP highlighted on the Control panel.  Alternatively, click Actions on 
the Menu panel, and select Call Pick-Up from the drop-down list. 

3) You answer the call on the contact’s behalf and the Switchboard panel shows a new 
“Active” line representing this call. 

7.7 Conduct Operator Call Barge-in  

Operator Call Barge-in allows the operator to barge in on a contact’s call.  This is useful 
when you want to enter an already established call between two other people.  This 
functionality is only available if you have been assigned this service by your group/system 
administrator. 

To conduct a call barge-in: 

1) Select a contact who you want to barge in on.  The contact’s status must be “Busy”. 

2) Click CALL BARGE-IN highlighted on the Control panel.  Alternatively, click Actions 
on the Menu panel, and select Call Barge-in from the drop-down list. 

 

Figure 71  Call Barge-in Button 

You enter an ongoing call, thereby establishing a Three-Way Conference. 

7.8 Managing Conference Calls  

Click Conference so you are allowed to participate in Three-Way Conference calls.  The 
button is dull or subdued in appearance when this action is not an option.  Alternatively, 
click Actions on the Menu panel, and select Conference from the drop-down list. 

 

Figure 72  Conference Button 

7.8.1 Start Conference Call  

To start a conference: 

1) Select the calls.  Choose both parties with whom you want to conduct a conference 
from the Switchboard panel. 
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2) Link the two calls by clicking on both their “LINK” entries.  One chain link should 
appear in each respective entry. 

 

Figure 73  Linked Switchboard Panel 

3) On the Control panel, click Conference.  Alternatively, click Actions on the Menu bar, 
and select Conference from the drop-down list. 

 

Figure 74  Conference Button 

Both calls become Active. 

7.8.2 Hold Conference Call  

To hold an active conference, click HOLD CONFERENCE on the Control panel.  
Alternatively, click Actions on the Menu panel, and select Hold Conference from the drop-
down list. 

 

Figure 75  Hold Conference Button 

 

Figure 76  Held Conference Switchboard Panel 

The conference link icon changes when this button is pressed.  The conference is held. 

 

Figure 77  Active Conference Switchboard Panel 
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7.8.3 Unhold Conference Call  

To reactivate a held conference: 

When a conference is held, the call status for the parties involved shows On Hold. 

 

Figure 78  Unhold Conference Button 

Click UNHOLD CONFERENCE on the Control panel.  Alternatively, click Actions on the 
Menu panel, and select Unhold Conference from the drop-down list.  Both call states 
change to Active when the action is complete. 

 

Figure 79  Active Conference Switchboard Panel 

7.8.4 Leave Conference Call  

To exit from a conference, click LEAVE CONFERENCE on the Control panel.  
Alternatively, click Actions on the Menu panel, and select Leave Conference from the 
drop-down list. 

 

Figure 80  Leave Conference button 

This removes the user from the conference call although the two other parties involved in 
the conference call are still connected.  The two parties are removed from the Switchboard 
panel. 

7.8.5 End Conference Call  

To end a conference call, click END CONFERENCE on the Control panel.  Alternatively, 
click Actions on the Menu panel, and select End Conference from the drop-down list. 

 

Figure 81  End Conference Button 

The calls are removed from the switchboard and terminated. 
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8  Managing Directories 

The Contact Directory panel in Reception Console allows you to view, search, and edit a 
variety of different types of directories. 

The Status column of the Contact Directory and any custom contact directory shows the 
contact’s phone on-hook/off-hook state.  The color of the state is customizable through the  
Tools – Options – Themes dialog box.  The following colors represent the different 
automated states: 

Status Icon Description 

Green Handset Down 
 

Contact phone is on-hook (available to receive a call) 
(previously this was a green triangle). 

Red Handset Up 
 

Contact phone is off-hook (on a call, busy)  
(previously this was a red triangle). 

Orange Handset Down 
 

Contact phone is ringing  
(previously this was a blue triangle). 

Do Not Disturb 
 

Contact phone has status set to “DND”  
(previously this was an orange triangle). 

Grey Handset Down 
 

Contact phone state is currently unavailable or 
unknown (previously there was no triangle or it was 
blank). 

Private 
 

Contact phone state is set to “private”. 

Call Forwarding Always 
 

Contact has the Call Forwarding Always service turned 
on.  By hovering your mouse over the contact, the user 
can see the phone number the contact has set the Call 
Forward to. 

 

8.1 View Directory  

To view a directory, click View in the Menu panel. 

From the Directories drop-down list, check the directory you want visible.  This includes 
custom contact directories. 

8.2 Hide Directory  

To hide a directory, click View in the Menu panel. 

From the Directories drop-down list, uncheck the directory you want invisible. 

Alternatively, click the x on the Directory tab. 

8.3 Select Directory 

Use the Contact Directory tab list to select the directory displayed in the Contact Directory 
panel. 

 

Figure 82  Directory Heading Tabs 
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8.4 Search Directory  

The keyword search feature is located below the Contact Directory list area. 

 

Figure 83  Search Directory 

To conduct a keyword search: 

1) Select the search by clicking inside the Text Search area of the Contact Directory. 

2) Enter a keyword (or part of a keyword). 

NOTE:  The keyword search is NOT case sensitive; the search for “Ann” or “ann” returns the 
same results. 

3) Select the directory from the Contact Directory drop-down list. 

4) Select the search criteria filter from the Keyword Search Filter drop-down list section 
of the Contact Directory.  Available criteria filters are All (default), Full Name – a 
combination of the first and last name, First Name, Last Name, Title, Department, 
Extension, Phone Number, and Notes. 

5) Click Search. 

Reception Console returns all the contacts in the Contact Directory that contain the 
entered keyword as any part of the selected filter (directory column(s)).  For example, 
entering “Ann” and selecting “First Name” from the Keyword Search Filter drop-down 
list returns all contacts with the first name “Ann”, but it also returns also all contacts 
with first names such as “Anne”, “Marianne”, “Marie Ann”, “Ann Marie”, and so on. 

6) To return to the full directory, click Reset. 

8.5 Manage Speed Dial Entries  

There are two types of speed dial entries:  Speed Dial 8 and Speed Dial 100.  

 Speed Dial 8.  With Speed Dial 8, Reception Console provides eight predefined 
empty slots, numbered 2 through 9.  Speed Dial 8 entries cannot be added or deleted; 
they can only be edited.  You can assign dialing information to a Speed Dial 8 entry 
and change or delete dialing information by editing the corresponding slot. 

 Speed Dial 100.  With Speed Dial 100, you can add up to 100 entries.  You can also 
modify or delete existing Speed Dial 100 entries. 

8.5.1 Edit Speed Dial 8 Entry  

You can assign, modify, or remove dialing information from a Speed Dial 8 entry using the 

Edit  button, located at the bottom right-hand corner of the Contact Directory panel. 
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8.5.1.1 Assign Dialing Information to Speed Dial 8 Slot 

1) In the Speed Dials directory, select an empty Speed Dial 8 slot. 

2) Click Edit. 

 

Figure 84  Assign Dialing Information to Speed Dial 8 Slot 

3) In the dialog box that appears, enter the phone number and description. 

4) To save the entry, click OK.  Click Cancel to exit without saving your changes. 

8.5.1.2 Modify or Delete Assigned Speed Dial 8 Entry 

1) In the Speed Dials directory, select an assigned Speed Dial 8 slot. 

2) Click Edit. 

Reception Console opens a dialog box in which you can edit the information. 

 

Figure 85  Edit Speed Dial 8 Entry 

3) Modify or delete information as desired.  Note, however, that you cannot delete the 
phone number and leave the description.  If you try to do that, an error message 
appears. 

4) To save the entry, click OK.  Click Cancel to exit without saving your changes. 
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8.5.2 Add Speed Dial 100 Entry  

You add a Speed Dial 100 entry using the Add button  located at the bottom right-
hand corner of the Contact Directory panel. 

1) Select the Speed Dials Directory tab. 

2) Click Add. 

Reception Console opens a window in which you enter the information. 

 

Figure 86  Add Speed Dial Dialog Box 

3) Select a key value from the drop-down list.  The key value determines what numbers 
you have to press on your phone to dial this Speed Dial entry. 

4) Enter the phone and description. 

5) To save the new entry, click OK.  Click Cancel to exit without creating the new entry. 

8.5.3 Edit Speed Dial 100 Entry  

You can edit an existing Speed Dial 100 entry using the Edit button  located at the 
bottom right-hand corner of the Contact Directory panel. 

1) Select the Speed Dials Directory tab. 

2) Click the desired Speed Dial 100 entry. 

3) Click Edit. 

Reception Console opens a dialog box in which you can modify the information. 

 

Figure 87  Edit Speed Dial 100 Entry 

4) Change the displayed values as desired. 

5) To save the entry, click OK.  Click Cancel to exit without saving your changes. 
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8.5.4 Delete Speed Dial 100 Entry  

You can delete an existing Speed Dial 100 entry using the Delete button  located at 
the bottom right-hand corner of the Contact Directory panel. 

1) Select the Speed Dials Directory tab. 

2) Click the desired Speed Dial 100 entry. 

3) Click Delete. 

4) Click Yes to confirm your action. 

 

Figure 88  Confirmation Dialog Box 
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9 Glossary  

Name Description 

Active Call This is the call you are currently talking to or dealing with. 

Ringing (In) This is the equivalent to a phone ringing locally. 

Calling Party This is the party who you are receiving a call from. 

Called Party This is the party that you have dialed. 

Music on Hold This is music that is streaming from the service provider for a 
held call. 

Ringing (Out) This is equivalent to a phone ringing on the called party’s 
phone. 
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10 Keyboard Shortcuts  

The following is a listing of keystrokes (shortcut keyboard entries) that are available in 
Reception Console. 

10.1 General Control Keys  

Key Strokes Equivalent Mouse Action Function 

ESCAPE Click OK/CANCEL/EXIT. Exits from the active window. 

 

10.2 Menu Bar Control Keys  

Key Strokes Equivalent Mouse Action Function 

Alt + O Click on Tools and then Options. Displays Options dialog box. 

Alt + R Click on Tools and then Call 
History. 

Displays Call History dialog box. 

Alt + H Click on Help and then User Guide. Opens NGT Reception Console User 
Guide. 

Alt + L Click on File and then Logout. Logs out current user from Reception 
Console and returns to login screen. 

 

10.3 Switchboard Control Keys  

Key Strokes Equivalent Mouse Action Function 

Ctrl + F1…F10 Click on the Link column for a call on 
the switchboard. 

Displays the link symbol in the Link 
column for the call.  F1 links the first 
call, F2 links the second call, and so 
on.  Two calls must be selected for a 
successful link. 

Shift + F1…F10 Click on a call on the switchboard. Select the call.  F1 selects the first 
call, F2 selects the second call, and 
so on. 
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10.4 Contact Directory Control Keys  

Key Strokes Equivalent Mouse Action Function 

Ctrl + F Click on text entry space for keyword 
search. 

Cursor appears in text entry space 
for entry of search keyword. 

Ctrl + R Click on Reset. Resets the search filter and shows 
the current directory. 

Ctrl + Shift + <alpha> Enter a single alphabetical character 
in the Search field and then select a 
filter from the search filter drop-down 
list. 

Apply filter on sorted column. 

Ctrl + UP/DOWN Select a filter from the Search filter. Traverses through the Search filter 
values. 

UP/DOWN/RIGHT/LEFT ARROW Click on each contact on the Contact 
panel in List view. 

Selects the contacts on the list. 

Page UP/DOWN Scroll through the contact list. Pages through the contacts on the 
list. 

 

10.5 Option Control Keys  

Key Strokes Equivalent Mouse Action Function 

<Number Pad /> Click on Extension. Selects the extension number of the 
selected contact. 

<Number Pad *> Click on Mobile. Selects the mobile number of the 
selected contact. 

<Number Pad -> Click on Voice Mail. Selects the voice mail number of the 
selected contact. 

<Number Pad 0,1…9> Click on Number Pad 0, 1,…9. Enters the corresponding number in 
the dialing pad. 
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10.6 Control Keys  

Key Strokes Equivalent Mouse Action Function 

ENTER Click Dial. Dials the selected number. 

<Number Pad +> Click Transfer. Transfers the selected call. 

Shift + <Number Pad +> Click Camp On/Camp Off. Camps on/off the selected call. 

<Number Pad .> Click End. Ends the selected call. 

Space Bar Click Answer after selecting a call 
on the switchboard, or double-click 
an incoming call on the Switchboard 
panel. 

Answers the longest waiting incoming 
call.  Multiple presses of the space 
bar answers the next call while 
placing the previous active call on 
hold. 

F1…F10 Click Answer after selecting a call 
on the switchboard, or double-click 
an active call on the Switchboard 
panel. 

Sets a call to “Active” from “Ringing”.  
F1 applies to the first call listed on the 
switchboard; F2 applies to the 
second call, and so on. 

F1…F10 Click Hold after selecting a call on 
the switchboard, or double-click an 
active call on the Switchboard 
panel. 

Sets a call to “On Hold” from “Active”.  
F1 applies to the first call listed on the 
switchboard; F2 applies to the 
second call, and so on. 

F1…F10 Click Unhold after selecting a call 
on the switchboard, or double-click 
a held call on the Switchboard 
panel. 

Sets a call to “Active” from “On Hold”.  
F1 applies to the first call listed on the 
switchboard; F2 applies to the 
second call, and so on. 

Shift + Ctrl + F1…F10  
OR  
<Number Pad/Del> 

Click a call on the switchboard to 
select it and then click on End to 
end the call. 

Ends the call.  F1 ends the first call; 
F2 ends the second call, and so on. 

<Number Pad +> Click Blind Transfer/Consult 
Transfer/Queue Transfer/Voice 
Mail Transfer. 

Blind Transfer/Consultative 
Transfer/Queue Transfer/Voice Mail 
Transfer to selected call or call 
option. 

Ctrl + <Number Pad +> Click Conference/Call 
Pickup/Barge-in. 

Initiates a conference with linked call 
lines.  Performs Pickup/Barge-in on 
selected contact. 

Ctrl + Alt + <Number Pad +> Click Conference 
Hold/Conference Unhold. 

Toggles a conference from Held to 
Active state. 

Ctrl + Shift + <Number Pad +> Click End Conference. Ends a conference.  Releases all 
parties from the conference. 

Ctrl + Alt + Shift + <Number Pad +> Click Exit Conference. Exits a conference.  Other parties 
remain connected. 
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